
Q .1Q .1 Whic h Union Terr itory  of Ind ia  had the highes t  s ex rat io ,  acc ording to  the C ens usWhic h Union Terr itory  of Ind ia  had the highes t  s ex rat io ,  acc ording to  the C ens us
2 0 1 1 ?2 0 1 1 ?

A nsA ns 1. 
2. 
3. 
4. 

Q .2Q .2 The Batt le of  Kannauj  in 1 54 0  marks  the v ic tory  of S her  S hah S ur i  over  whic hThe Batt le of  Kannauj  in 1 54 0  marks  the v ic tory  of S her  S hah S ur i  over  whic h
M ughal  emperor?M ughal  emperor?

A nsA ns 1. Shah Jahan 
2. Humayun
3. Aurangzeb
4. Bahadur Shah I 

Q .3Q .3 Who took  over  as  the C hief Jus t ice of Ind ia  (C J I )  from C J I  DY  C handrac hud on 1 1Who took  over  as  the C hief Jus t ice of Ind ia  (C J I )  from C J I  DY  C handrac hud on 1 1
November 2 0 24 ?November 2 0 24 ?

A nsA ns 1. Justice Surya Kant
2. Justice Hrishikesh Roy
3. Justice Bhushan Ramkrishna Gavai
4. Justice Sanjiv Khanna

Q .4Q .4 The S alary  of  the C hief Jus t ice of Ind ia  is  mentioned in whic h of the fo l lowingThe S alary  of  the C hief Jus t ice of Ind ia  is  mentioned in whic h of the fo l lowing
s c hedules?s c hedules?

A nsA ns 1. Second schedule
2. Fourth schedule
3. First schedule
4. Third schedule
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Q . 5Q . 5 Who defeated Ibrahim L odi  in the firs t  Batt le of  Panipat  and c onWho defeated Ibrahim L odi  in the firs t  Batt le of  Panipat  and c on quered Delhi?quered Delhi?
A nsA ns 1. Babur

2. Akbar
3. Aurangzeb
4. Shah Jahan

Q .6Q .6 Whic h of the fo l lowing c ommittees  rec ommended that  'Duty  to  pay  taxes  s houldWhic h of the fo l lowing c ommittees  rec ommended that  'Duty  to  pay  taxes  s hould
als o  be a  Fundamental  Duty  of the c it izens '?als o  be a  Fundamental  Duty  of the c it izens '?

A nsA ns 1. Nachiket Committee
2. Poonchi Committee
3. Sarkaria Committee
4. Swaran Singh Committee

Q .7Q .7 The final  populat ion data of C ens us  2 0 1 1  was  releas ed in whic h y ear?The final  populat ion data of C ens us  2 0 1 1  was  releas ed in whic h y ear?
A nsA ns 1. 2012

2. 2014

3. 2013
4. 2011

Q .8Q .8 Whic h organis at ion launc hed the 'S amarth'  inc ubation program in M arc h 2 0 2 5 toWhic h organis at ion launc hed the 'S amarth'  inc ubation program in M arc h 2 0 2 5 to
s upport  s tartups  in the telec om and IT  s ec tors?s upport  s tartups  in the telec om and IT  s ec tors?

A nsA ns 1. Software Technology Parks of India (STPI)

2. Ministry of Electronics and Information Technology (MeitY)
3. Centre for Development of Telematics (C-DOT)
4. National Informatics Centre (NIC)

Q .9Q .9 Whic h of the fo l lowing r ivers  forms  the eas tern boundary  of the Himalay as?Whic h of the fo l lowing r ivers  forms  the eas tern boundary  of the Himalay as?
A nsA ns 1. Brahmaputra

2. Teesta
3. Manas
4. Subansiri
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Q .1 0Q .1 0 Whic h organis at ion was  awarded the 'Udy og V ikas  A ward '  for  its  c ontr ibution toWhic h organis at ion was  awarded the 'Udy og V ikas  A ward '  for  its  c ontr ibution to
trans forming India’s  indus tr ia l  and logis t ic al  lands c ape in 2 0 2 5?trans forming India’s  indus tr ia l  and logis t ic al  lands c ape in 2 0 2 5?

A nsA ns 1. NITI Aayog
2. Invest India
3. Industrial Finance Corporation of India
4. National Industrial Corridor Development Corporation

Q .1 1Q .1 1 Whic h c ountry  was  elec ted as  a  member of the 1 5- member of s teer ing c ommitteeWhic h c ountry  was  elec ted as  a  member of the 1 5- member of s teer ing c ommittee
of the G lobE  Network  in 2 0 24 ?of the G lobE  Network  in 2 0 24 ?

A nsA ns 1. United States of America
2. Canada
3. Sri Lanka
4. India

Q .1 2Q .1 2 The c al l  of  'Do or  D ie'  was  given by  M ahatma G andhi  dur ing the launc h of whic hThe c al l  of  'Do or  D ie'  was  given by  M ahatma G andhi  dur ing the launc h of whic h
of the fo l lowing S aty agrahas/ M ovements?of the fo l lowing S aty agrahas/ M ovements?

A nsA ns 1. Non-cooperation Movement
2. Champaran Satyagraha
3. Quit India Movement
4. Bardoli Satyagraha

Q .1 3Q .1 3 Who among the fo l lowing was  appointed as  the new C hief Jus t ice of Ind ia  inWho among the fo l lowing was  appointed as  the new C hief Jus t ice of Ind ia  in
November 2 0 2 2 ?November 2 0 2 2 ?

A nsA ns 1. Sharad Arvind Bobde
2. DY Chandrachud
3. NV Ramana
4. Ranjan Gogoi

Q .1 4Q .1 4 In whic h part  of  Ind ia  is  red s o i l  mos t ly  found?In whic h part  of  Ind ia  is  red s o i l  mos t ly  found?
A nsA ns 1. Chota Nagpur Plateau

2. Upper Ganga Plains
3. Thar desert
4. Northwest Himalaya
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Q .1 5Q .1 5 What s ignific ant event d id  L ord M ountbatten pres ent in June 1 947?What s ignific ant event d id  L ord M ountbatten pres ent in June 1 947?
A nsA ns 1. The plan for partition of India

2. The Quit India Movement
3. The Cripps Mission
4. The Cabinet Mission Plan

Q .1 6Q .1 6 What was  the venue of 1 9What was  the venue of 1 9t ht h  s ummit  of Non- A l igned M ovement in 2 0 24 ? s ummit of Non- A l igned M ovement in 2 0 24 ?

A nsA ns 1. Tehran, Iran
2. Kampala, Uganda
3. Baku, Azerbaijan
4. New Delhi, India

Q .1 7Q .1 7 In whic h of the fo l lowing y ears  was  the Firs t  Round Table C onference held?In whic h of the fo l lowing y ears  was  the Firs t  Round Table C onference held?
A nsA ns 1. 1932

2. 1928
3. 1930
4. 1929

Q .1 8Q .1 8 From 1 991  to  2 0 1 9 ,  former Pr ime M inis ter  M anmohan S ingh was  a  M ember ofFrom 1 991  to  2 0 1 9 ,  former Pr ime M inis ter  M anmohan S ingh was  a  M ember of
Par l iament from whic h of the fo l lowing s tates/ UTs?Par l iament from whic h of the fo l lowing s tates/ UTs?

A nsA ns 1. Punjab
2. Assam
3. Chandigarh
4. Rajasthan

Q .1 9Q .1 9 How old  d id  Internat ional  L abour  O rganizat ion ( ILO)  bec ome in 2 0 24 ?How old  d id  Internat ional  L abour  O rganizat ion ( ILO)  bec ome in 2 0 24 ?
A nsA ns 1. 105 years

2. 102 years
3. 110 years
4. 100 years
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Q .2 0Q .2 0 A cc ording to  the Indian M ineral  Yearbook  2 0 2 2 ,  whic h of the fo l lowing s tatesA cc ording to  the Indian M ineral  Yearbook  2 0 2 2 ,  whic h of the fo l lowing s tates
c ontr ibuted to  4 1 % c ontr ibuted to  4 1 % of the bauxite produc tion in Ind ia?of the bauxite produc tion in Ind ia?

A nsA ns 1. Bihar
2. Jharkhand
3. Chhattisgarh
4. Odisha

Q .2 1Q .2 1 If  ‘+ ’ means  ‘÷ ’ ,  ‘− ’ means  ‘+ ’ ,  ‘× ’ means  ‘− '  and ‘÷ ’ means  ‘× ’ ,  then what wi l l  be theIf  ‘+ ’ means  ‘÷ ’ ,  ‘− ’ means  ‘+ ’ ,  ‘× ’ means  ‘− '  and ‘÷ ’ means  ‘× ’ ,  then what wi l l  be the
value of the fo l lowing expres s ion?value of the fo l lowing expres s ion?
( ( 2 3  ×  1 6)  − ( 2  ÷  4) )  + ( 3  − 2 )( ( 2 3  ×  1 6)  − ( 2  ÷  4) )  + ( 3  − 2 )

A nsA ns 1. 2
2. 4
3. 3
4. 1

Q .2 2Q .2 2 S elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed atS elec t  the c orrec t  mirror  image of the given figure when the mirror  is  placed at
M N as  s hown below.M N as  s hown below.

A nsA ns 1. 

2. 

3. 

4. 

Section : Logical Reasoning
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Q .2 3Q .2 3 Refer  to  the fo l lowing s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting toRefer  to  the fo l lowing s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to
be done from left  to  r ight  only .be done from left  to  r ight  only .

( L eft)  M  ( L eft)  M  S  S  U U K K Y  Y  N N J  J  L  L  B  B  W W X X  I  I  P  P  E  E  U U D D C  C  O  ( Right)O  ( Right)

Whic h letter  is  s ec ond to  the left  of  the fifth letter  from the r ight  end in theWhic h letter  is  s ec ond to  the left  of  the fifth letter  from the r ight  end in the
given s er ies?given s er ies?

A nsA ns 1. B
2. J
3. Y
4. I

Q .24Q .24 Two s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certainTwo s ets  of  numbers  are given below.  In eac h s et  of  numbers ,  certain
mathematic al  operat ion(s)  on the firs t  number res ults  in the s ec ond number.mathematic al  operat ion(s)  on the firs t  number res ults  in the s ec ond number.
S imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  in theS imilar ly ,  certain mathematic al  operat ion(s)  on the s ec ond number res ults  in the
third  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  ofthird  number and s o  on.  Whic h of the given options  fo l lows  the s ame s et  of
operat ions  as  in the given s ets?  operat ions  as  in the given s ets?  
( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3as  adding /  s ubtrac t ing /  mult iply ing to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

1 4 - 84 -74 - 1 4 8;  1 5- 90 - 80 - 1 601 4 - 84 -74 - 1 4 8;  1 5- 90 - 80 - 1 60
A nsA ns 1. 16-96-76-152

2. 13-78-88-176
3. 17-102-92-174
4. 12-72-62-124
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Q .2 5Q .2 5 Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting toRefer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to
be done from left  to  r ight  only .be done from left  to  r ight  only .
( L eft)  D  A  I  J  C  U L  O  I  L  Q  U P  L  Z  C  E  B  J  A  G  X  ( Right)( L eft)  D  A  I  J  C  U L  O  I  L  Q  U P  L  Z  C  E  B  J  A  G  X  ( Right)
How many  s uc h vowels  are there eac h of whic h is  immediately  preceded by  aHow many  s uc h vowels  are there eac h of whic h is  immediately  preceded by  a
c ons onant and als o  immediately  fo l lowed by  a  c ons onant?c ons onant and als o  immediately  fo l lowed by  a  c ons onant?

A nsA ns 1. Four
2. One
3. Three
4. Two

Q .2 6Q .2 6 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certainIn the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing certain
mathematic al  operat ions  to  the firs t  number.  S elec t  the s et  in whic h themathematic al  operat ions  to  the firs t  number.  S elec t  the s et  in whic h the
numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  numbers  are related in the s ame way  as  are the numbers  of the fo l lowing s ets .  

3 5,  1 0 53 5,  1 0 5
47,  1 4 147,  1 4 1

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  its  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h asdown the numbers  into  its  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h as
adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3adding /  s ubtrac t ing /mult iply ing etc .  to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )  a l lowed . )  

A nsA ns 1. 12, 52
2. 22, 110
3. 36, 74
4. 28, 84

Q .2 7Q .2 7 In a  c las s  of  s tudents ,  Ram is  1 7In a  c las s  of  s tudents ,  Ram is  1 7t ht h  from the top and 3 from the top and 3r dr d  from the bottom.  What is from the bottom.  What is
the total  number of s tudents  in that  c las s?the total  number of s tudents  in that  c las s?

A nsA ns 1. 
2. 
3. 
4. 

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q .2 8Q .2 8 H,  I ,  J ,  K ,  S,  T  and U are s itt ing around a c irc ular  table fac ing the centre of theH,  I ,  J ,  K ,  S,  T  and U are s itt ing around a c irc ular  table fac ing the centre of the
table.  O nly  two people s it  between H and U when c ounted from the r ight  of H .table.  O nly  two people s it  between H and U when c ounted from the r ight  of H .
O nly  three people s it  between S  and K when c ounted from the r ight  of K .  U s its  toO nly  three people s it  between S  and K when c ounted from the r ight  of K .  U s its  to
the immediate r ight  of K .  J  s its  to  the immediate r ight  of T.the immediate r ight  of K .  J  s its  to  the immediate r ight  of T.
Who s its  fourth to  the r ight  of I?Who s its  fourth to  the r ight  of I?

A nsA ns 1. H
2. S
3. J
4. K

Q .2 9Q .2 9 Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .Refer  to  the fo l lowing letter  s er ies  and ans wer  the ques t ion that  fo l lows .
(C ounting to  be done from left  to  r ight  only . )(C ounting to  be done from left  to  r ight  only . )
( L eft)  A  ( L eft)  A  X  X  N N S  S  I  I  T  T  E  E  D  D Y  Y  W W O  O  V  V  U U Q  Q  G  G  E  E  J  J  M  M  E  E  U ( Right)U ( Right)
How many  s uc h vowels  are there,  eac h of whic h is  immediately  preceded by  aHow many  s uc h vowels  are there,  eac h of whic h is  immediately  preceded by  a
c ons onant and als o  immediately  fo l lowed by  a  c ons onant?c ons onant and als o  immediately  fo l lowed by  a  c ons onant?

A nsA ns 1. Four
2. Five
3. Two
4. More than five

Q .3 0Q .3 0 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in theIf  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the
number 573 1 4 68,  whic h of the fo l lowing d igits  wi l l  be s ec ond from the left  in thenumber 573 1 4 68,  whic h of the fo l lowing d igits  wi l l  be s ec ond from the left  in the
new number thus  formed?new number thus  formed?

A nsA ns 1. 5
2. 8

3. 6
4. 2
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Q .3 1Q .3 1 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies  to  makeWhat s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies  to  make
the s er ies  logic al ly  c omplete?the s er ies  logic al ly  c omplete?

51 7  51 7  51 9 51 9 52 3  52 3  52 5 52 5 52 9 52 9 ??
A nsA ns 1. 531

2. 534
3. 533
4. 532

Q .3 2Q .3 2 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

67  67  65 65 61  61  53  53  3 7  3 7  ??
A nsA ns 1. 7

2. 4

3. 6
4. 5

Q .3 3Q .3 3 S elec t  the pair  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s etsS elec t  the pair  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two s ets
of pairs  given below.  Both pairs  fo l low the s ame pattern.of  pairs  given below.  Both pairs  fo l low the s ame pattern.

HJM  :  PRUHJM  :  PRU
L NQ  :  TV YL NQ  :  TV Y

A nsA ns 1. SUX : BCE
2. TVX : ADF
3. TUY : ACE
4. SUX : ACF

Q .3 4Q .3 4 D is  the brother  of L .  C  is  the mother  of D.  A  is  the brother  of B.  C  is  the s is ter  ofD is  the brother  of L .  C  is  the mother  of D.  A  is  the brother  of B.  C  is  the s is ter  of
B.  How is  D  related to  A ?B.  How is  D  related to  A ?

A nsA ns 1. Sister’s son
2. Sister
3. Father
4. Brother
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Q .3 5Q .3 5 S elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iadsS elec t  the tr iad  that  fo l lows  the s ame pattern as  that  fo l lowed by  the two tr iads
given below.  Both tr iads  fo l low the s ame pattern.given below.  Both tr iads  fo l low the s ame pattern.
A C  – E G  – IKA C  – E G  – IK
JL  – NP – RTJL  – NP – RT

A nsA ns 1. MO – QS – UW
2. RM – QT – PR
3. BF – EI – HL
4. PL – RN – TP

Q .3 6Q .3 6 Refer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting toRefer  to  the given letter  s er ies  and ans wer  the ques t ion that  fo l lows .  C ounting to
be done from left  to  r ight  only .be done from left  to  r ight  only .

( L eft)  ( L eft)  L  L  A  A  I  I  G  G  V  V  T  T  S  S  K K E  E  I  I  O  O  M  M  P P  N N Q  Q  R R W W Z Z  B  B  C  C  F F A  A  ( Right)  ( Right)  

How many  s uc h vowels  are there,  eac h of whic h is  immediately  preceded by  aHow many  s uc h vowels  are there,  eac h of whic h is  immediately  preceded by  a
vowel  and als o  immediately  fo l lowed by  a  vowel?vowel  and als o  immediately  fo l lowed by  a  vowel?

A nsA ns 1. One
2. Two
3. Three
4. Four

Q .3 7Q .3 7 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in theIf  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the
number 873 64 561 ,  what wi l l  be d ifference between the greates t  and s mal les tnumber 873 64 561 ,  what wi l l  be d ifference between the greates t  and s mal les t
d igits  thus  formed?digits  thus  formed?

A nsA ns 1. 5
2. 3
3. 7
4. 6
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Q .3 8Q .3 8 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. EGI
2. HKL
3. LNP
4. DFH

Q .3 9Q .3 9 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or  their
pos it ion in the letter- c lus ter. )pos it ion in the letter- c lus ter. )

A nsA ns 1. YUT
2. VSQ
3. DZY
4. CYX

Q .4 0Q .4 0 S elec t  the pair  that  fo l lows  the s ame pattern as  the one fo l lowed by  the twoS elec t  the pair  that  fo l lows  the s ame pattern as  the one fo l lowed by  the two
pairs  given below.  Both pairs  fo l low the s ame pattern.pairs  given below.  Both pairs  fo l low the s ame pattern.

FE D :  BA ZFE D :  BA Z
L KJ  :  HG FL KJ  :  HG F

A nsA ns 1. VUT : SQQ
2. WUS : RPQ
3. VUT : RQP
4. WUS : SQP

Section : General English and Comprehension
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Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

By  the t ime we arr ived ,  the gues ts  had already  _____ .By  the t ime we arr ived ,  the gues ts  had already  _____ .
A nsA ns 1. left

2. leave
3. leaves
4. leaving

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

M eera wore a  beautiful  dres s  with _____ embroidery .M eera wore a  beautiful  dres s  with _____ embroidery .
A nsA ns 1. spacious

2. apprehensive
3. intricate
4. uncouth

Q .43Q .43 S elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined word inS elec t  the mos t appropr iate option that  c an s ubs t itute the under l ined word in
the given s entence.the given s entence.
The s tudent ’s  The s tudent ’s  d i l igentdi l igent  work  led  to  excel lent  res ults . work  led  to  excel lent  res ults .

A nsA ns 1. thorough
2. careless
3. timid
4. relaxed

Q .4 4Q .4 4 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.
M ake a mountain out of a  molehi l lM ake a mountain out of a  molehi l l

A nsA ns 1. To avoid interfering in a situation
2. To explore mountainous regions
3. To exaggerate a minor problem
4. To undertake an ambitious project

https://applink.adda247.com/d/XhqWf9lSap
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Q .4 5Q .4 5 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

A  pers on who s tudies  plantsA  pers on who s tudies  plants
A nsA ns 1. Zoologist

2. Geologist
3. Botanist
4. Ecologist

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions daily. Far
beyond the absence of mental illness, it represents a state where individuals recognise
their abilities, manage life's stresses, work effectively, and contribute to society. In today's
demanding world, mental health's significance is increasingly clear. Pressures from
academics, work, and social norms can trigger challenges like anxiety and depression. The
World Health Organisation reports that one in four people will experience a mental health
disorder, underscoring the urgent need for awareness and understanding. Crucially, mental
health profoundly impacts physical health. Studies indicate that poor mental well-being
elevates the risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress can
manifest physically. Consequently, prioritising good mental health is vital for both
emotional equilibrium and physical wellness.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 S elec t  the mos t appropr iate t it le for  the pas s age.S elec t  the mos t appropr iate t it le for  the pas s age.
A nsA ns 1. Strategies for Achieving Emotional Equilibrium and Social Contribution

2. The Foundational Role of Mental Well-being in Overall Health
3. Understanding and Addressing Mental Health Disorders Globally
4. The Interplay Between Stress, Mental Health, and Physical Illness

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions daily. Far
beyond the absence of mental illness, it represents a state where individuals recognise
their abilities, manage life's stresses, work effectively, and contribute to society. In today's
demanding world, mental health's significance is increasingly clear. Pressures from
academics, work, and social norms can trigger challenges like anxiety and depression. The
World Health Organisation reports that one in four people will experience a mental health
disorder, underscoring the urgent need for awareness and understanding. Crucially, mental
health profoundly impacts physical health. Studies indicate that poor mental well-being
elevates the risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress can
manifest physically. Consequently, prioritising good mental health is vital for both
emotional equilibrium and physical wellness.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 What is  one thing that  ind iv iduals  in a  s tate of mental  wel l - being are able to  do?What is  one thing that  ind iv iduals  in a  s tate of mental  wel l - being are able to  do?
A nsA ns 1. Completely avoid all forms of stress and pressure

2. Achieve extraordinary levels of wealth and fame
3. Recognise their abilities and manage life's stresses
4. Ignore the needs and well-being of others

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions daily. Far
beyond the absence of mental illness, it represents a state where individuals recognise
their abilities, manage life's stresses, work effectively, and contribute to society. In today's
demanding world, mental health's significance is increasingly clear. Pressures from
academics, work, and social norms can trigger challenges like anxiety and depression. The
World Health Organisation reports that one in four people will experience a mental health
disorder, underscoring the urgent need for awareness and understanding. Crucially, mental
health profoundly impacts physical health. Studies indicate that poor mental well-being
elevates the risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress can
manifest physically. Consequently, prioritising good mental health is vital for both
emotional equilibrium and physical wellness.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 What does  mental  wel l - being fundamental ly  enc ompas s?What does  mental  wel l - being fundamental ly  enc ompas s?
A nsA ns 1. The ability to achieve academic and professional success

2. Solely the absence of mental illness
3. Emotional, psychological, and social health
4. Primarily physical health and the absence of disease

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions daily. Far
beyond the absence of mental illness, it represents a state where individuals recognise
their abilities, manage life's stresses, work effectively, and contribute to society. In today's
demanding world, mental health's significance is increasingly clear. Pressures from
academics, work, and social norms can trigger challenges like anxiety and depression. The
World Health Organisation reports that one in four people will experience a mental health
disorder, underscoring the urgent need for awareness and understanding. Crucially, mental
health profoundly impacts physical health. Studies indicate that poor mental well-being
elevates the risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress can
manifest physically. Consequently, prioritising good mental health is vital for both
emotional equilibrium and physical wellness.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

E nc ompas sE nc ompas s
A nsA ns 1. Exclude

2. Contain
3. Circulate
4. Demand
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

Mental well-being, encompassing emotional, psychological, and social health, is
fundamental to our overall health. It shapes our thoughts, feelings, and actions daily. Far
beyond the absence of mental illness, it represents a state where individuals recognise
their abilities, manage life's stresses, work effectively, and contribute to society. In today's
demanding world, mental health's significance is increasingly clear. Pressures from
academics, work, and social norms can trigger challenges like anxiety and depression. The
World Health Organisation reports that one in four people will experience a mental health
disorder, underscoring the urgent need for awareness and understanding. Crucially, mental
health profoundly impacts physical health. Studies indicate that poor mental well-being
elevates the risk of chronic conditions such as heart disease, diabetes, and obesity. This
powerful mind-body connection demonstrates that stress and emotional distress can
manifest physically. Consequently, prioritising good mental health is vital for both
emotional equilibrium and physical wellness.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50

Q . 50Q . 50 Why  is  pr ior it is ing good mental  health c ons idered v ita l ,  bas ed on the informationWhy  is  pr ior it is ing good mental  health c ons idered v ita l ,  bas ed on the information
provided?provided?

A nsA ns 1. Because it guarantees financial success and career advancement
2. Because it ensures complete immunity from all forms of illness
3. Because it is essential for both emotional equilibrium and physical wellness
4. Because it eliminates all forms of social and academic pressures

Section : General Hindi and Comprehension
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Q . 51Q . 51 ‘‘ अखंडअखंड ’ ’ काका   प य] यवा चीप य] यवा ची   शbशb   हो गाहो गा --
A nsA ns 1. अपूणh

2. खंड
3. पूणh
4. अंश

Q . 52Q . 52 '' समा ससमा स '  '  काका   kवलो मkवलो म   शbशb   हैहै --
A nsA ns 1. kवnेद

2. qास
3. समrय
4. kवsह

Q . 53Q . 53 सवt uचतसवt uचत   का र कका र क   uचxuचx   सेसे   yद एyद ए   ग एग ए   वा {वा {   काका   |र }|र }   ~ा न~ा न   प ूणhप ूणh   क र�क र� ——

म�नेम�ने   क भीक भी   अप नेअप ने   समयसमय  . . . . . .   . . . . . .  दु� प यो गदु� प यो ग   नह�नह�   िक यािक या ।।
A nsA ns 1. का

2. म�
3. पर
4. से

Q . 54Q . 54 kन��ल�ख तkन��ल�ख त   मुहा वरेमुहा वरे   काका   सहीसही   अथhअथh   प हचा न�प हचा न� ।।
मु��मु��   ग र मग र म   क र नाक र ना ।।

A nsA ns 1. |र�त देना
2. �ोध आना
3. िकसी को मारना
4. सद� लगना

Q . 55Q . 55 '' अंगअंग -- अंगअंग   ढ� लाढ� ला   हो नाहो ना '  '  मुहा वरामुहा वरा   काका   सहीसही   अथhअथh   हो गाहो गा  - -
A nsA ns 1. सुखी जीवन qतीत करना

2. वृ� होना
3. अ��धक कोमल होना
4. थकान होना

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:
ग��श के आधार पर kन��ल�खत ��� के उ¡र दी�जए-
'kमथक' शb अंsेजी के ‘kमथ’ से गढ़ �लया गया है और उसका yहदंी �kत�प बन गया है । kमथ शb का उ¥व यूनानी
शb ‘kमथॉस’ से हुआ है,�जसका अथh है ‘मंुह से kनकला हुआ’। अत: उसका स§¨ ‘मौ�खक कथा’ से जुड़ गया {�िक
कथा भी सुनी सुनायी जाती थी। yहदंी म� kमथक के �लए ‘पुरावृ¡’, ‘पुराकथा’, ‘पुराणकथा’ आyद अनेक शb �यु} होते
रहे ह�। «¬ है िक इनसे ‘kमथ’ के पूरे  अथh का स®ेषण नह� हो पाता। इस �kतशb� म� या तो अqा°± दोष है या
अkतqा°±। इस�लए yहदंी म� भी ‘kमथक’ शb का �योग ही समीचीन है। 
व²ुत: kमथक का स§¨ आyदम लोक मानस से है। अपनी सरलतम प|रभाषा म� “kमथक एक कथा है, �जसम� सृि¬
और उसके उपकरण� के उ¥व, उसक´ गkति�या और उस पर kनयंµण, उसके अबूझ qापार, मूलभूत मानवीय
ि�याओं और सम¸ाओं, �kत�प� और त¹�, जीवन मरण आyद kवहंगम kवषय� को लेकर आरº कालीन धारणाएं,
uचंताएं, kव�ास और त»ंबंधी कमhक�ड को अ�भq¼} kमली है।”

S ubQ ues t ion No :  56S ubQ ues t ion No :  56

Q . 56Q . 56 '' kमथkमथ '  '  शbशb   काका   अथhअथh   {ा{ा   हैहै  ? ?
A nsA ns 1. �योग िकया हुआ

2. मंुह से kनकला हुआ
3. सुना हुआ
4. पढ़ा हुआ
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C omprehens ion:C omprehens ion:
ग��श के आधार पर kन��ल�खत ��� के उ¡र दी�जए-
'kमथक' शb अंsेजी के ‘kमथ’ से गढ़ �लया गया है और उसका yहदंी �kत�प बन गया है । kमथ शb का उ¥व यूनानी
शb ‘kमथॉस’ से हुआ है,�जसका अथh है ‘मंुह से kनकला हुआ’। अत: उसका स§¨ ‘मौ�खक कथा’ से जुड़ गया {�िक
कथा भी सुनी सुनायी जाती थी। yहदंी म� kमथक के �लए ‘पुरावृ¡’, ‘पुराकथा’, ‘पुराणकथा’ आyद अनेक शb �यु} होते
रहे ह�। «¬ है िक इनसे ‘kमथ’ के पूरे  अथh का स®ेषण नह� हो पाता। इस �kतशb� म� या तो अqा°± दोष है या
अkतqा°±। इस�लए yहदंी म� भी ‘kमथक’ शb का �योग ही समीचीन है। 
व²ुत: kमथक का स§¨ आyदम लोक मानस से है। अपनी सरलतम प|रभाषा म� “kमथक एक कथा है, �जसम� सृि¬
और उसके उपकरण� के उ¥व, उसक´ गkति�या और उस पर kनयंµण, उसके अबूझ qापार, मूलभूत मानवीय
ि�याओं और सम¸ाओं, �kत�प� और त¹�, जीवन मरण आyद kवहंगम kवषय� को लेकर आरº कालीन धारणाएं,
uचंताएं, kव�ास और त»ंबंधी कमhक�ड को अ�भq¼} kमली है।”

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 ग �� शग �� श   म�म�   � यु}� यु}   � kत � प� kत � प   शbशb   काका   अथhअथh   हो गाहो गा  - -
A nsA ns 1. �बु�

2. �kतमा
3. प¾र
4. पकवान
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C omprehens ion:C omprehens ion:
ग��श के आधार पर kन��ल�खत ��� के उ¡र दी�जए-
'kमथक' शb अंsेजी के ‘kमथ’ से गढ़ �लया गया है और उसका yहदंी �kत�प बन गया है । kमथ शb का उ¥व यूनानी
शb ‘kमथॉस’ से हुआ है,�जसका अथh है ‘मंुह से kनकला हुआ’। अत: उसका स§¨ ‘मौ�खक कथा’ से जुड़ गया {�िक
कथा भी सुनी सुनायी जाती थी। yहदंी म� kमथक के �लए ‘पुरावृ¡’, ‘पुराकथा’, ‘पुराणकथा’ आyद अनेक शb �यु} होते
रहे ह�। «¬ है िक इनसे ‘kमथ’ के पूरे  अथh का स®ेषण नह� हो पाता। इस �kतशb� म� या तो अqा°± दोष है या
अkतqा°±। इस�लए yहदंी म� भी ‘kमथक’ शb का �योग ही समीचीन है। 
व²ुत: kमथक का स§¨ आyदम लोक मानस से है। अपनी सरलतम प|रभाषा म� “kमथक एक कथा है, �जसम� सृि¬
और उसके उपकरण� के उ¥व, उसक´ गkति�या और उस पर kनयंµण, उसके अबूझ qापार, मूलभूत मानवीय
ि�याओं और सम¸ाओं, �kत�प� और त¹�, जीवन मरण आyद kवहंगम kवषय� को लेकर आरº कालीन धारणाएं,
uचंताएं, kव�ास और त»ंबंधी कमhक�ड को अ�भq¼} kमली है।”

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 ग �� शग �� श   केके   �लए�लए   उ प यु}उ प यु}   शी ष hकशी षhक   काका   चयनचयन   क´ �जएक´ �जए --
A nsA ns 1. �पक

2. kमथक
3. �तीक
4. kब§
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C omprehens ion:C omprehens ion:
ग��श के आधार पर kन��ल�खत ��� के उ¡र दी�जए-
'kमथक' शb अंsेजी के ‘kमथ’ से गढ़ �लया गया है और उसका yहदंी �kत�प बन गया है । kमथ शb का उ¥व यूनानी
शb ‘kमथॉस’ से हुआ है,�जसका अथh है ‘मंुह से kनकला हुआ’। अत: उसका स§¨ ‘मौ�खक कथा’ से जुड़ गया {�िक
कथा भी सुनी सुनायी जाती थी। yहदंी म� kमथक के �लए ‘पुरावृ¡’, ‘पुराकथा’, ‘पुराणकथा’ आyद अनेक शb �यु} होते
रहे ह�। «¬ है िक इनसे ‘kमथ’ के पूरे  अथh का स®ेषण नह� हो पाता। इस �kतशb� म� या तो अqा°± दोष है या
अkतqा°±। इस�लए yहदंी म� भी ‘kमथक’ शb का �योग ही समीचीन है। 
व²ुत: kमथक का स§¨ आyदम लोक मानस से है। अपनी सरलतम प|रभाषा म� “kमथक एक कथा है, �जसम� सृि¬
और उसके उपकरण� के उ¥व, उसक´ गkति�या और उस पर kनयंµण, उसके अबूझ qापार, मूलभूत मानवीय
ि�याओं और सम¸ाओं, �kत�प� और त¹�, जीवन मरण आyद kवहंगम kवषय� को लेकर आरº कालीन धारणाएं,
uचंताएं, kव�ास और त»ंबंधी कमhक�ड को अ�भq¼} kमली है।”

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 ग �� शग �� श   म�म�   � यु}� यु}   आ yद मआ yद म   काका   प य] यवा चीप य] यवा ची   शbशb   हो गाहो गा  - -
A nsA ns 1. आर¿ºक

2. वतhमान
3. भkवÀ
4. अंkतम
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C omprehens ion:C omprehens ion:
ग��श के आधार पर kन��ल�खत ��� के उ¡र दी�जए-
'kमथक' शb अंsेजी के ‘kमथ’ से गढ़ �लया गया है और उसका yहदंी �kत�प बन गया है । kमथ शb का उ¥व यूनानी
शb ‘kमथॉस’ से हुआ है,�जसका अथh है ‘मंुह से kनकला हुआ’। अत: उसका स§¨ ‘मौ�खक कथा’ से जुड़ गया {�िक
कथा भी सुनी सुनायी जाती थी। yहदंी म� kमथक के �लए ‘पुरावृ¡’, ‘पुराकथा’, ‘पुराणकथा’ आyद अनेक शb �यु} होते
रहे ह�। «¬ है िक इनसे ‘kमथ’ के पूरे  अथh का स®ेषण नह� हो पाता। इस �kतशb� म� या तो अqा°± दोष है या
अkतqा°±। इस�लए yहदंी म� भी ‘kमथक’ शb का �योग ही समीचीन है। 
व²ुत: kमथक का स§¨ आyदम लोक मानस से है। अपनी सरलतम प|रभाषा म� “kमथक एक कथा है, �जसम� सृि¬
और उसके उपकरण� के उ¥व, उसक´ गkति�या और उस पर kनयंµण, उसके अबूझ qापार, मूलभूत मानवीय
ि�याओं और सम¸ाओं, �kत�प� और त¹�, जीवन मरण आyद kवहंगम kवषय� को लेकर आरº कालीन धारणाएं,
uचंताएं, kव�ास और त»ंबंधी कमhक�ड को अ�भq¼} kमली है।”

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 kमथकkमथक   शbशb   अंs ेजीअंs ेजी   केके   िक सिक स   शbशb   सेसे   �लया�लया   ग याग या   हैहै   ??
A nsA ns 1. kमथ शb से

2. इमै�जनेशन शb से
3. kमथॉस शb से

4. एलेगर� शb से

Q .61Q .61 Whic h of the fo l lowing is  c orrec t  i f  y ou s imultaneous ly  place a  row above row 3Whic h of the fo l lowing is  c orrec t  i f  y ou s imultaneous ly  place a  row above row 3
and a c o lumn to  the r ight  of c o lumn D?and a c o lumn to  the r ight  of c o lumn D?

A nsA ns 1. Select row 3 and column D, then press Ctrl + Shift + '+'.
2 . Use the Insert options menu separately for rows and columns.
3. Perform two separate insert actions.
4. This action can be performed simultaneously in Excel.

Q .62Q .62 What does  the TE XT func t ion in M S  E xcel  do?What does  the TE XT func t ion in M S  E xcel  do?
A nsA ns 1. Converts dates into numeric values

2. Converts numeric values to text in a specific number format
3. Converts text to numeric values
4. Converts text to uppercase or lowercase

Section : Basic Knowledge of Computer
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Q .63Q .63 What happens  when one us es  the 'Pas te'  c ommand in M S  Word 2 0 1 9?What happens  when one us es  the 'Pas te'  c ommand in M S  Word 2 0 1 9?
A nsA ns 1. It pastes text from the clipboard into the document.

2. It applies a new style to the text.
3. It saves the document.
4. It deletes the selected text.

Q .64Q .64 Whic h of the fo l lowing indus tr ies  is  part ic ular ly  vulnerable to  c y ber  attac ks  andWhic h of the fo l lowing indus tr ies  is  part ic ular ly  vulnerable to  c y ber  attac ks  and
thus  requires  s trong c y bers ec ur ity  meas ures?thus  requires  s trong c y bers ec ur ity  meas ures?

A nsA ns 1. Agriculture
2. Retail and e-commerce
3. Construction
4. Mining

Q .65Q .65 Whic h key board s hortc ut key  c ombinat ion is  us ed for  Keep Text  O nly  optionWhic h key board s hortc ut key  c ombinat ion is  us ed for  Keep Text  O nly  option
while pas t ing in an M S  Word doc ument?while pas t ing in an M S  Word doc ument?

A nsA ns 1. Ctrl + Shift + H
2. Ctrl + Shift + Q
3. Ctrl + Shift + V
4. Ctrl + Shift + O

Q .66Q .66 Whic h key board s hortc ut c an be us ed to  quic k ly  open a pres entat ion in M ic ros oftWhic h key board s hortc ut c an be us ed to  quic k ly  open a pres entat ion in M ic ros oft
PowerPoint?PowerPoint?

A nsA ns 1. Ctrl + O
2. Ctrl + P
3. Ctrl + S
4. Ctrl + N

Q .67Q .67 If  a  us er  is  aware of the file path,  how c an they  open a doc ument in M ic ros oftIf  a  us er  is  aware of the file path,  how c an they  open a doc ument in M ic ros oft
Word?Word?

A nsA ns 1. By dragging and dropping the document onto the Word application icon
2. By saying 'Open document' to a voice-controlled assistant
3. By tapping the document on a touchscreen device
4. By using the 'File' menu and selecting the 'Open' option
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Q .68Q .68 What does  the s ett ing 'C o l late'  mean when pr int ing mult iple c opies  of  a  mult i -What does  the s ett ing 'C o l late'  mean when pr int ing mult iple c opies  of  a  mult i -
page doc ument in M S  Word 2 0 1 9?page doc ument in M S  Word 2 0 1 9?

A nsA ns 1. To skip the even-numbered pages
2. To print only the first page
3. To arrange pages in sequential order for each copy
4. To change the orientation of the document

Q .69Q .69 In mos t word- proces s ing appl ic at ions ,  whic h of the fo l lowing key board s hortc utsIn mos t word- proces s ing appl ic at ions ,  whic h of the fo l lowing key board s hortc uts
is  c ommonly  us ed to  c ut  the s elec ted text?is  c ommonly  us ed to  c ut  the s elec ted text?

A nsA ns 1. Ctrl+Z
2. Ctrl+C
3. Ctrl+X
4. Ctrl+V

Q .70Q .70 Whic h of the fo l lowing ac t ions  is  ty pic al ly  the firs t  s tep in c reat ing a newWhic h of the fo l lowing ac t ions  is  ty pic al ly  the firs t  s tep in c reat ing a new
doc ument in M S  Word?doc ument in M S  Word?

A nsA ns 1. Formatting the document's layout
2. Selecting 'Open' from the File menu
3. Choosing 'New' from the File menu or clicking the 'New Document' icon
4. Printing the document

Q .71Q .71 Whic h of the fo l lowing bes t  des c r ibes  the Unified Pay ments  Interface ( UPI) ?Whic h of the fo l lowing bes t  des c r ibes  the Unified Pay ments  Interface ( UPI) ?
A nsA ns 1. A messaging service for secure communication between banks

2. A biometric authentication system for financial transactions
3. A mobile-based payment system that allows users to link multiple bank accounts to

a single mobile application for instant money transfers
4. A payment system that allows users to make cashless transactions using a physical

card

Q .72Q .72 Whic h of the fo l lowing mobi le operat ing s y s tems  is  known for  its  s trong s ec ur ityWhic h of the fo l lowing mobi le operat ing s y s tems  is  known for  its  s trong s ec ur ity
features  and is  often us ed in enterpr is e environments?features  and is  often us ed in enterpr is e environments?

A nsA ns 1. Android
2. Windows Phone
3. BlackBerry OS
4. Apple iOS
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Q .73Q .73 You need to  c hange the s y s tem date and t ime on y our  Windows  1 0  operat ingYou need to  c hange the s y s tem date and t ime on y our  Windows  1 0  operat ing
s y s tem.  Whic h of the fo l lowing s teps  c orrec t ly  out l ines  the proces s?s y s tem.  Whic h of the fo l lowing s teps  c orrec t ly  out l ines  the proces s?

A nsA ns 1. Open the Start menu, select Settings, click on System, then select Date & time, and
use the Change date and time button to modify the settings.

2. Open the Start menu, select Control Panel, click on System and Security, then select
Date & time, and use the Modify button to change the settings.

3. Open the Start menu, select Control Panel, click on Date and Time, and then use the
Change date and time button to modify the settings.

4. Open the Start menu, select Settings, click on Time & language, then select Date &
time, and use the Change button to modify the settings.

Q .74Q .74 Whic h of the fo l lowing options  is  us ed to  open an exis t ing doc ument in M ic ros oftWhic h of the fo l lowing options  is  us ed to  open an exis t ing doc ument in M ic ros oft
Word?Word?

A nsA ns 1. File > Save
2. File > Open
3. Edit > Open
4. File > New

Q .75Q .75
A nsA ns 1. 

2. 
3. 
4. 

Q .76Q .76
A nsA ns 1. 

2. 
3. 
4. 

Q .77Q .77 What is  the purpos e of the ‘Pr int  Preview’ feature in M S  E xcel  2 0 1 9?What is  the purpos e of the ‘Pr int  Preview’ feature in M S  E xcel  2 0 1 9?
A nsA ns 1. To edit the spreadsheet content

2. To format the cells automatically
3. To display how the spreadsheet will look when printed
4. To save the spreadsheet in a different format
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Q .78Q .78 Identify  the prominent tool  ut i l is ed for  fetc hing data from the web.Identify  the prominent tool  ut i l is ed for  fetc hing data from the web.

A nsA ns 1. Google
2. LinkedIn
3. Facebook
4. Twitter

Q .79Q .79 Whic h of the fo l lowing is  a  pr imary  advantage of us ing c redit  c ards  over  debitWhic h of the fo l lowing is  a  pr imary  advantage of us ing c redit  c ards  over  debit
c ards?c ards?

A nsA ns 1. Credit cards can only be used for online transactions.
2. Credit cards do not require a PIN for transactions.
3. Credit cards have lower interest rates than debit cards.
4. Credit cards offer a grace period to pay back the amount without interest.

Q .80Q .80 What is  the pr imary  reas on for  the need of c y ber  s ec ur ity ?What is  the pr imary  reas on for  the need of c y ber  s ec ur ity ?
A nsA ns 1. To increase the storage capacity of computer devices

2. To prevent unauthorised access to computer systems and networks
3. To enhance the speed of internet connections
4. To improve the graphical user interface (GUI) of software applications

Q .81Q .81 A n item is  marked 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s omeA n item is  marked 75% higher  than its  c os t  pr ice.  E ven after  a l lowing s ome
dis c ount ,  the s hopkeeper  earned 5% profit .  F ind the d is c ount percentage al loweddis c ount ,  the s hopkeeper  earned 5% profit .  F ind the d is c ount percentage al lowed
by  the s hopkeeper.by  the s hopkeeper.

A nsA ns 1. 40%
2. 41%

3. 37%
4. 42%

Q .82Q .82

A nsA ns 1. 0
2. −1
3. 1
4. 2

Section : Quantitative Aptitude
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Q .83Q .83 The rat io  of  Rithu's  inc ome and s av ings  is  1 0  :  3.  F ind the expenditure ( in ₹)  i f  herThe rat io  of  Rithu's  inc ome and s av ings  is  1 0  :  3.  F ind the expenditure ( in ₹)  i f  her
s avings  are ₹1 2 ,0 0 0 .s av ings  are ₹1 2 ,0 0 0 .

A nsA ns 1. ₹26,000
2. ₹28,000
3. ₹36,000
4. ₹24,000

Q .84Q .84 E valuate the fo l lowing:E valuate the fo l lowing:

1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 1 0 ) } ]1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 1 0 ) } ]
A nsA ns 1. 1665

2. 1450
3. 1590
4. 1520

Q .85Q .85 3  t imes  the pres ent age of D iks ha is  1 2  y ears  more than 3  t imes  the pres ent age3  t imes  the pres ent age of D iks ha is  1 2  y ears  more than 3  t imes  the pres ent age
of A mit ,  and 9  t imes  the pres ent age of A mit  is  6  y ears  les s  than 6  t imes  theof A mit ,  and 9  t imes  the pres ent age of A mit  is  6  y ears  les s  than 6  t imes  the
pres ent age of D iks ha .  The s um of the pres ent ages  ( in y ears)  of  D iks ha and A mitpres ent age of D iks ha .  The s um of the pres ent ages  ( in y ears)  of  D iks ha and A mit
is :is :

A nsA ns 1. 13

2. 20
3. 16
4. 15

Q .86Q .86 The value ofThe value of

A nsA ns 1. −7
2. −3
3. −2
4. −5
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Q .87Q .87 The s um of the pres ent ages  of Nares h and his  father  is  4 8 y ears .  A fter  fourThe s um of the pres ent ages  of Nares h and his  father  is  4 8 y ears .  A fter  four
y ears ,  the age of the father  wi l l  be three t imes  that  of  Nares h.  Their  pres enty ears ,  the age of the father  wi l l  be three t imes  that  of  Nares h.  Their  pres ent
ages ,  res pec t ively ,  are:ages ,  res pec t ively ,  are:

A nsA ns 1. 10 years, 38 years
2. 12 years, 44 years
3. 16 years, 40 years
4. 20 years, 36 years

Q .88Q .88 A  dealer  buy s  two art ic les  X  and Y  for  ₹1 ,70 0  eac h.  He marks  eac h of them at  theA  dealer  buy s  two art ic les  X  and Y  for  ₹1 ,70 0  eac h.  He marks  eac h of them at  the
s ame pr ice.  He s el ls  X  by  giv ing two s ucces s ive d is c ounts  of 2 1 % and 52 % and s t i l ls ame pr ice.  He s el ls  X  by  giv ing two s ucces s ive d is c ounts  of 2 1 % and 52 % and s t i l l
earns  ₹986 as  profit .  I f  he s el ls  Y  at  a  s ingle d is c ount of 61 %, then what is  theearns  ₹986 as  profit .  I f  he s el ls  Y  at  a  s ingle d is c ount of 61 %, then what is  the
profit percentage on Y?profit percentage on Y?

A nsA ns 1. 
2. 
3. 
4. 

Q .89Q .89 The s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 andThe s um of five numbers  is  655.  The average of the firs t  two numbers  is  75 and
the third  number is  1 0 5.  F ind the average of the remaining two numbers?the third  number is  1 0 5.  F ind the average of the remaining two numbers?

A nsA ns 1. 200
2. 180
3. 181
4. 201

Q .90Q .90 A  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  HeA  retai ler  buy s  an elec tronic  item for  ₹1 80 .  H is  overhead expens es  are ₹2 0 .  He
s el ls  the elec tronic  item for  ₹3 0 0  and makes  x% profit .  The value of x  is :s el ls  the elec tronic  item for  ₹3 0 0  and makes  x% profit .  The value of x  is :

A nsA ns 1. 70
2. 30
3. 40
4. 50
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Q .91Q .91 A  s hopkeeper  l is ts  the pr ice of a  fan at  4 0 % above its  c os t  pr ice and offers  aA  s hopkeeper  l is ts  the pr ice of a  fan at  4 0 % above its  c os t  pr ice and offers  a
2 0 % dis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 1 1 ,  then what is  the l is t2 0 % dis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 1 1 ,  then what is  the l is t
pr ice ( in ₹)  of  the fan?pr ice ( in ₹)  of  the fan?

A nsA ns 1. 1,135
2. 1,022
3. 1,224
4. 1,295

Q .92Q .92 The average of 6 . 5,  1 0 .6 ,  2 0 .2  and a is  1 8 .  The value of a  is :The average of 6 . 5,  1 0 .6 ,  2 0 .2  and a is  1 8 .  The value of a  is :
A nsA ns 1. 35.7

2. 36.7
3. 34.7
4. 33.7

Q .93Q .93 The d ifference between the value of a  number inc reas ed by  1 8% and the value ofThe d ifference between the value of a  number inc reas ed by  1 8% and the value of
the s ame number dec reas ed by  1 8% is  3 0 3.1 2 .  F ind the number.the s ame number dec reas ed by  1 8% is  3 0 3.1 2 .  F ind the number.

A nsA ns 1. 840
2. 848
3. 842
4. 844

Q .94Q .94 If  4% of x  =  2 0 4 ,  then x  = ?If  4% of x  =  2 0 4 ,  then x  = ?
A nsA ns 1. 5100

2. 10300
3. 5200
4. 10200

Q .95Q .95 E valuate the fo l lowing:E valuate the fo l lowing:

1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 9) } ]1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 9) } ]
A nsA ns 1. 1449

2. 1519
3. 1664
4. 1589
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Q .96Q .96 In an elec t ion between two c andidates  A  and B,  80 % of the voters  c as t  theirIn an elec t ion between two c andidates  A  and B,  80 % of the voters  c as t  their
votes ,  out  of whic h 2 % votes  were dec lared inval id .  A  got  1 2 , 54 4  votes ,  whic hvotes ,  out  of whic h 2 % votes  were dec lared inval id .  A  got  1 2 , 54 4  votes ,  whic h
were 80 % of the total  val id  votes .  F ind the total  number of voters  in thatwere 80 % of the total  val id  votes .  F ind the total  number of voters  in that
elec t ion.elec t ion.

A nsA ns 1. 25,000
2. 22,000
3. 20,000
4. 16,000

Q .97Q .97 A  pers on c an c omplete a  journey  in 6  hours .  He c overs  the firs t  one- third  part  ofA  pers on c an c omplete a  journey  in 6  hours .  He c overs  the firs t  one- third  part  of
the journey  at  a  rate of 60  km/ hr  and the remaining d is tance at  a  rate of 4 0the journey  at  a  rate of 60  km/ hr  and the remaining d is tance at  a  rate of 4 0
km/ hr.  What is  the total  d is tance ( in km)  of his  journey ?km/ hr.  What is  the total  d is tance ( in km)  of his  journey ?

A nsA ns 1. 270
2. 279
3. 266
4. 274

Q .98Q .98 A  c ar  moves  from point  A  to  B  at  a  s peed of 3 0  km/ h and c omes  bac k  at  a  s peedA  c ar  moves  from point  A  to  B  at  a  s peed of 3 0  km/ h and c omes  bac k  at  a  s peed
of 50  km/ h.  Find the average s peed .of 50  km/ h.  Find the average s peed .

A nsA ns 1. 40 km/h
2. 37.5 km/h
3. 35.5 km/h
4. 42.5 km/h

Q .99Q .99 A dity a and Bhas kar  undertake to  do a piece of work  for  ₹1 5,0 0 0 .  A dity a a lone c anA dity a and Bhas kar  undertake to  do a piece of work  for  ₹1 5,0 0 0 .  A dity a a lone c an
do it  in 1 5 day s  whi le Bhas kar  a lone c an do it  in 1 8  day s .  With the help of C handra ,do it  in 1 5 day s  whi le Bhas kar  a lone c an do it  in 1 8  day s .  With the help of C handra ,
they  finis h it  in 6  day s .  What is  C handra’s  s hare?they  finis h it  in 6  day s .  What is  C handra’s  s hare?

A nsA ns 1. ₹4,000 
2. ₹5,000
3. ₹6,000
4. ₹7,000
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Q .1 0 0Q .1 0 0 Three pipes ,  A ,  B  and C ,  c an fil l  a  tank  in 1 2  hours .  A fter  work ing at  it  together  forThree pipes ,  A ,  B  and C ,  c an fil l  a  tank  in 1 2  hours .  A fter  work ing at  it  together  for
3  hours ,  C  is  c los ed ,  and A  and B  c an fil l  the remaining part  in 1 0  hours .  The3  hours ,  C  is  c los ed ,  and A  and B  c an fil l  the remaining part  in 1 0  hours .  The
number of hours  taken by  C  a lone to  fil l  the tank  is :number of hours  taken by  C  a lone to  fil l  the tank  is :

A nsA ns 1. 60 hours
2. 120 hours
3. 15 hours
4. 30 hours
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